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ABSTRACT

We introduce you this report to show the
techniques of MS Word™ that facilitate writing a
report using the amazing tools of MS Word™,

Ibrahim ALIBRAHIM

25-Jan-13

Write your report
with MS Word™

How to use MS Word™ in writing your paper
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MS Word™ in Writing a paper HIAST

1 Introduction

We use MS Word™ in our daily life to write reports, letters, and papers in many
fields. A few people know about the abilities that MS Word™ has, which help a lot
making the task of writing so easy and smooth. MS Word™ helps you with inserting an
automatic table of contents, table of references, headers and footers, alignment, and
review.

This report will show you the special utilities of MS Word™ as a strong and
powerful program in the field of writing. It will not focus on dummy tasks like how to
change your font properties (type, size, and color), but it will show you how to use MS
Word™ with organizing a report (insert table of contents, generate the references
automatically, justify your text...). It will also give you some advices about the structure
of a report and some writing rules (like punctuation and font properties...).

We will organize this report to be easy to be searched and for you to find what you
need easily. We will talk about each tab in MS Word™ with its purpose and provide.
Each paragraph title will have the purpose of the tab implicitly, and in case the tab title
cannot give the idea, we write the purpose explicitly between brackets.

As MS Word™ version are pretty the same since version 2007 (2010 and 2013), we
depend on version 2010 to be the main version that we take the explanation and the
images from.

2 Report Structure

Each report differ in structure according to its nature and field, like if it is a scientific
report, a book, or a free writing. We intend to talk about the structure of the scientific
report.

The main points will listed in order bellow.

2.1 Cover page

This page contains the main title of the report, subtitle, author(s), publisher, and
publishing date. Try to make the main title as expressive as possible and add some
clarification and justification in the subtitle. In the field of the author, write your name
and your supervisor(s). The publisher may be the real publishing house of the report or
the company that you are writing under it (your university or institute...).

1 ILALIBRAHIM
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Page

2.2

Insert a built-in cover page from MS Word™ through the tab INSERT then Cover

and
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5

Contrast

Figure 1 Insert Cover Page

choose one.

This built-in cover page gives you automatic fields to be filled of your choice.

1%t section (Structure)

2.2.1 Abstract
In this section, you need to revise your report in few lines, which express the whole
idea of your report and what you are going to talk about. Try to make it clear and simple
because in most cases the reader of your report will decide whether to continue reading or
not after reading the abstract.

I.LALIBRAHIM
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2.2.2 Table of Contents
The table of contents shows the paragraphs’ titles with their page numbers.

Contents
1 Introduction

2  Report Structure

21 EEET [£2 /5 nooooom0000005000000000300 090 980 00000000300 030 980003 0000000030 J50 003 000 0a0AE0N0 A 00N N0A0NAC0N0NOR 000 000D
2.2 1% section (Structure)

2.21 Abstract

2.2.2 Table of Contents

Figure 2 Table of Contents

To generate automatic table of contents you should firstly make some Headings to
provide MS Word™, which titles to contain in the table. In order to mark pieces of text to
be contained in the contents table, mark the title and press one of the headings that you
will find in the Home tab.

AaBbCcDc | AaBbCcDe AaBbCi( AaBbCc Aa B|
T Marmal | T MNo Spaci.. Heading 1 Heading 2 Title

Figure 3 Headings

Try to numerate the title in a hierarchical way. Use multilevel list auto numeration to
help you doing what you need.

SE| #EEE vl Sl T | paencene

Current List
1. —
a.
i
List Library
1) 1.
Mone a) 1.4,
]
1 Heading 1
1.1 Heading 2
. 1.1.1 Heading 3
* Aricle L4 11,1 Heading 4
E Section 1| 1.1.1.1.1 Heading 5
(a) Heac 1.1.1.1.1.1 Heading &
1.1.1.1.1.1.1 Heading 7
1.1.1.1.1.1.1.1 Heading &
1.1.1.1.1.1.1.1.1 Heading &
|. Heading 1 Chapter sading

A, Heading | | Heading 2
1. Headin| | Heading 3

Figure 4Multilevel list auto numeration
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Choose the model viewed in figure 4 to auto numerate headings. Numeration gives
the report more organization.

If you wanted to modify the format of a heading, mark one of the titles that is already
defined to be heading x and modify it to suit you, then select it and press with the right
mouse key on heading x (in Home tab) and click “Update Heading x to Match Selection”.
Alternatively, click “Modify...” to reformat it.

AaBbC AaBbce AABI| 2esbcer

Headi Update Heading 1 to Match Selection
%4 Modify...
Select All: (Mo Data)

Rename...

Remove from Quick Style Gallery

Add Gallery to Quick Access Toolbar

Figure 5 Heading Properties

After marking all the desired titles to be headings (included in the table of contents),
you can now generate the built-in table from REFERENCES tab then click on Table of
Contents then choose either table 1 or table 2.

¢ Add Text ~ [[yInsert Endnote ]l’ I
= =i Update Table ﬁi Mext Footnote - = i
Table of Insert B Insert
Contents ~ Footnote J +N0W NOTES Citation = |{
| Built-In
Automatic Table 1
Contents
HIBBTIME L oo st 8 i 8 b it st L |
Heading 2 1 |
Automatic Table 2
lable of Contents
HIBBTIMED L it s 8 b b L
Heading 2 1

Figure 6 Insert table of contents
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After generating the table, you can update it any time you want by clicking on the
button “Update Table” which gives you two choices.

Update Table of Contents &léj

Word is updating the table of contents. Select one of
the following options:
(@) iUpdate page numbers onlyi

(71 Update entire table

QK ] [ Cancel

Figure 7 Update Table of Contents Dialog

2.2.3 Table of Figures
The table of figures shows every figure with its title and page number.

In order to generate a table of figure you should mark the figures. Mark a figure by
clicking a right click on it and click “Insert Caption...”, then write the caption, which
express the figure’s title. You can notice that every figure has a label; this label
recognizes it to generate the table of figures later. You can change the label to be “Table”
for example to generate the list of tables later.

I Caption [P |

Caption:
Figure 1 Example1 |

Options
Label: Figure IEI
Position: | Below selected item |E|

[ Exdude label from caption

[Euto[:apﬁun... ] [ QK ] [ Cancel ]

Figure 8 Insert Caption

After marking all the figures in the paper, go to References tab and click on “Insert
Table of Figures”. A pop-up window will appear which sets the properties of the table.
Change the Caption label to include all the figures that have this label.
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Table of Figures m
| Index | Table of Contents | Table of Eigures | Table of Authorities
Print Preview Web Preview
Figure 1: Textonn, 1|« | |Figurel: Text |
L || Ld
Figure 2: Texto e ecec s 3 Figure 2: Text
i . |
Figure 3: TexXto e e 5 Figure 3: Text
. I
Figure 4: Text e i Figure 4: Text
Show page numbers s hyperlinks instead of page numbers |
Right align page numbers
Tab leader: |....... IEI

General
Formats: From template IEI
Caption label: |Figure
[¥] Indude labe &
Table ik
sl Iil [Qpﬁuns... ][ Modify. .. ]
gz
4 Bonary -

[ oK ][ Cancel ]

Figure 9 Generate a table of figures

Change the label to be “Table” to generate the list of tables.

Table of Figures

Figure 1 Insert Cover Page
Figure 2 Table of Contents
Figure 3 Headimgs el
Figure 4 Multilevel list auto numeration
Figure 5 Heading Properties el
Figure 6 Insert table of contents . ...
Figure 7 Update Table of Contents Dialog
Figure 8 Insert Caplion ...
Figure 9 Generate a table of figures

Figure 10 Example of table of figures

2.2.4 List of Tables
Follow the previous steps and change the caption label to “Table”.
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2.2.5 List of Abbreviations (Acronyms)
MS Word™ does not provide a built-in list of abbreviations, so you have to write it
by yourself. Include the abbreviation and its explanation in the table.

= You can set this list at this position or at the end of the paper before the references.

2.2.6  Contents (Body)

In this section, you should provide the substance of the paper. It must develop the
key idea and result and be organized so that the reader is convinced of its significance
and validity. Follow these rules to produce and organize the content of a paper (1).

1. Choose carefully the key idea and hold to it.
2. Design a scheme for the paper that best conveys the idea.
3. Demonstrate the result.

The contents must be organized to help the reader; numerate the titles using a
hierarchical way using multilevel list numbering.

2.2.7 Index

An index lists the terms and topics that are discussed in a document, along with the
pages that they appear on. To create an index, you mark the index entries by providing
the name of the main entry, and then you build the index.

To facilitate building the index, try to begin marking entries since the beginning of
writing your paper.

In order to mark an entry, mark the word (phrase) which represent the entry, and
click on “Mark Entry” in References tab; then just click on “Mark”.

Notice that each word should be marked as an entry to be found in the index.
Marking should be done each time the entry appears; that means each time the entry is
marked you will find the page number with the entry.

= Notice that when you mark an entry the format of the text is changed; go to home
tab and deactivate the button T or just click ctrl+shift+8.

=} Insert Index
ﬂ*

Mark
Entry

Index

Figure 11 Insert Index

After marking all the entries, click on “Insert Index” and choose the classic format to
sort the entries alphabetically.
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Index L ot m

Print Preview

~  Type: i@ Indented i) Run-n
A Il Columns: |2 Iil
Aristotle, 2 Language: |English u.s.) El
Asteroid belt. See Jupiter
Atmosphere
Earth
exosphere, 4 7

Right align page numbers

Tab leader: | Izl
Formats: | Classic Izl
Mark Entry. .. ] [ AutoMark. .. ] | Modify... |
o J[ concel |
Figure 12 Insert Index settings
A F
abbreviations, & figure, &
alphabetically, &
M
B
MS Word™, 3, 4
button, &
N
E
Mumeration, 5
entity, 8
T
table, &

Figure 13 an Example of Index
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2.2.8 References
List all your references to be found in one place and to be indexed by identities, these
ids could be unigque numbers (starting from 1) contained between brackets (ex: [1], or

1)).

Every listed reference must be used in the paper at least in one place. Write the
reference number using the previous format at the end of the place (sentence,
paragraph...) where you use it.

MS Word™ provides a built-in technique to facilitate the process of generating the
references. In the case of first usage of a reference, put the mouse pointer (writing
pointer) where you want to mention a reference and go the references tab then click on
“Insert Citation” and then “Add New Source...”

ﬁ [3) Manage Sources
= (3 Style: APA Fiftt ~
Insert o

Citation =| ! Bibliography ~
- &g Add New Source...

_?!.- Add Mew Placeholder...

Figure 14 Add new reference

You get a pop-up window that sets the information about the new source. Fill this
information noticing that MS Word™ gives you the main fields to be strictly filled, and
there are some other supplementary information. Set the language of the source to be
English or Arabic in order to generate the list of references correctly later.

| Create Source I. ? i:h]
Type of Source Eﬂ_lﬂ Language |Default |Z|
Bibliography Fields for APA Fifth Edition
Author
[T Corporate Authaor
Title
Year
City
Publisher

[7] show all Bibliography Fields
Tag name
Placehalder 1

oK ] [ Cancel

Figure 15 Create Source

To insert the same source again, go to “Add New Source...” and you will find the
added sources there, click on the source that you want.
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You can change the style of how the references are mentioned from the same
previous panel and change the style to be “ISO 690 — Numerical Reference” for example.

After finishing the paper, insert the list of references (bibliography) by clicking on
“Bibliography” which exists on the same previous panel, and then select a style for the
bibliography.

2.2.9 Acknowledgement

Thank all the people that helped you accomplishing your paper here. This paragraph
IS up to you.

2.2.10 Conclusion
The conclusion must summarize the paper contribution and emphasize the main

result. It can also address application of the result and open issues, and give future
research directions.

3 Bibliography
1. Valduriez, Patrick. Some Hints to ImproveWriting of Technical Papers.
Rocquencourt, France : Project Rodin, INRIA, 1994.

10 ILALIBRAHIM


https://www.researchgate.net/publication/243055419

